FIFTH GRADE BIWEEKLY OUTLINE
September 07 to 18, 2020

SCIENCE

Teacher: Julio J. La Roche Topic: Microorganisms 70 - 74.

INTRODUCTION

Over the next two weeks, you will be able to state the difference between health and illness. Additionally, you
will identify types of illnesses. Moreover, you will describe the microorganisms that affect the human body. In
this lesson, you will increase your critical thinking skills by answering analysis questions. In conclusion, you will
increase your analytical skills and improve the way you reflect on the topics presented in class.

CONTENT:

The following subtopics will be discussed:
e Health and IlIness.
e Types of Ilinesses.
e Bacteria, Fungi and Viruses.

LEARNING ACTIVITIES:

Activity #1: Read pages 70 and 74. Then, answer these questions in your Science notebook.

Workshop:

1. What does being healthy include?
How are illnesses defined?

How can illnesses be classified?
What are microorganisms?
Where do fungi grow?

How do viruses affect cells?
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Activity #2: Join a Zoom Meeting in which the teacher will explain the topic and conduct oral
assessments.

EVALUATION:
The workshop must be uploaded to our virtual learning platform. Use the “TAREAS” tool to complete

this step. You can either upload a Microsoft word file or a photo you have taken.

MATH

Teacher: Julio J. La Roche Topic: Lines, Segments and Rays Pages 76 -78

INTRODUCTION

Over the next two weeks, you will be able to recognize and explain lines and segments definitions. You will
identify rays and state their usage. Moreover, you will describe and explain what intersecting lines are. Finally,
you will improve your math skills and understand mathematical concepts.

CONTENT:

The following subtopics will be discussed:



e Lines and segments.
e Rays.
e Intersecting lines.

LEARNING ACTIVITIES:

Activity #1: Read the definition of lines, segments and rays on page 76 in your math textbook.

Activity #2: Join a Zoom Meeting in which the teacher will explain the topic.
Activity #3: Complete the test. “Lines, Segments and Rays”

Identify the lines, rays, line segments or intersecting lines. (8 points, 1 point each)

a.- b.-
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h.-

N

Identify the highlighted pair of lines in each object as parallel or perpendicular. (3 points, 1 point each)

a.- b.- C.-

g

Drawing lines, rays, or line segments. (3 points, 1 point each)

Draw a line here Draw a line segment here Draw a ray here




EVALUATION:

The test must be uploaded to our virtual learning platform. Use the “TAREAS” tool to complete this
step. You can either upload a Microsoft word file or a photo you have taken.

READING

Teacher: Julio J. La Roche Topic: Puzzles and Mysteries, pages 60 - 62.

INTRODUCTION

Over the next two weeks, you will develop a more positive attitude about reading in English. You will
be able to improve key reading skills such as skimming, scanning, identifying the main idea, and
guessing vocabulary from context. In this lesson, you will strengthen other skills such as grammar,
vocabulary, pronunciation, and writing. Lastly, you will to apply critical thinking skills to the reading
process.

SPECIFIC OBJECTIVES:

Upon completion of the lesson, you will be able to:

1. Develop a positive attitude to reading in English.

2. Improve key reading skills such as skimming, scanning, identifying the main idea, and
guessing vocabulary from context.

3. Strengthen other skills such as grammar, vocabulary, pronunciation, and writing.

4. Apply critical thinking skills to the reading process.

CONTENT:
The following subtopics will be discussed:

e Key Words.
e Finding Content Clues.

LEARNING ACTIVITIES:

Activity #1: Read pages 60 - 62 from your reading textbook. Next, write the key words from page 60
in your notebook. Then, look up their meanings in English and write them in your notebook. (Do not
upload this)

Activity #2: Join a Zoom Meeting in which the teacher will explain the topic and conduct oral
assessments.

Activity #3: Complete this workshop.
Workshop: Answer the questions in your notebook.

1. Who invented the Enigma Machine?
2. What did the Enigma Machine do?



When did the German Navy start to use this machine?
Where was the Bombed Machine invented?

Who improved the Bombed Machine?

What was this machine able to do?
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EVALUATION:

The workshop must be uploaded to our virtual learning platform. Use the “TAREAS” tool to complete
this step. You can either upload a Microsoft word file or a photo you have

TECHNOLOGY

Teacher: Julio J. La Roche Topic: Creating a PowerPoint Presentation

INTRODUCTION

Over the next two weeks, you will learn how to create a PowerPoint presentation. You will be able to
use correctly different tools to add a visually consistent and attractive appearance to your
presentation. Additionally, you will learn how to add text and pictures to your presentation. Also, you
will develop computer skills needed to complete school assignments.

CONTENT:

The following subtopics will be discussed:
1. Creating a PowerPoint presentation.
2. Selecting a template.

3. Adding text and pictures.

LEARNING ACTIVITIES:

Activity #1: Read this guide and create a simple presentation using Microsoft PowerPoint.

Basics Steps for Creating a PowerPoint Presentation

PowerPoint presentations work like slide shows. To convey a message or a story, you break it down
into slides. Think of each slide as a blank canvas for the pictures and words that help you tell your
story.

Creating a PowerPoint Slide

When you open PowerPoint, you’ll see some built-in themes and templates. A theme is a slide
design that contains matching colors, fonts, and special effects like shadows, reflections, and
more.

1. Click File and select New, from the drop down box and then choose a theme.

PowerPoint shows you a preview of the theme, with four color variations to choose from on
the right side.



2. Click Create, or pick a color variation and then click Create.

Create

Title Layout

‘ More iImages »

Insert a new slide

= On the Home tab, click the bottom half of New Slide, and pick a slide layout.
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Add text

Select a text placeholder, and begin typing.
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Format your text
1. Select the text.
2. Under Drawing Tools, choose Format.
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3. Do one of the following:
* To change the color of your text, choose Text Fill, and then choose a color.
*= To change the outline color of your text, choose Text Outline, and then choose a color.
= To apply a shadow, reflection, glow, bevel, 3-D rotation, a transform, choose Text Effects,
and then choose the effect you want.
Add pictures
On the Insert tab, do one of the following:
» To insert a picture that is saved on your local drive or an internal server, choose Pictures,
browse for the picture, and then choose Insert.
» To insert a picture from the web, choose Online Pictures, and use the search box to find a
picture.

Save your presentation
1. On the File tab, choose Save.
2. Pick or browse to a folder.
3. In the File name box, type a name for your presentation, and then choose Save.
Note: If you frequently save files to a certain folder, you can ‘pin’ the path so that it is always
available (as shown below).
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Activity #2: Complete this workshop.

Workshop: Create a six slide PowerPoint presentation about our country. You can research your own
information or you can use the information provided below. Save the file in your pendrive.



Panama City:

> State Capital

> Population of L4
million

> Central America

> Population density:
7,656/sq mi

Bocas del Toro

/ CoIé{

Panama (Central America)
‘il] .'I\
Panama

Coclé

"

Darién

Santos

Panama’s Flag

> The panama flag was adopted on

No r 3, 1903.
> The flag was modeled after the

USA flag

> The colored stars are said to

represent the countrys conservative
(red and liberal (blu
> White symbolizes peace.

parties.

> The stars and quarters represent
the rival political parties.

> The flag was made by Maria Ossa
de Amador.

a to the east, the Pac

Ocean to the south, and Costa Rica to the
west.

> Tt is roughly shaped like the letter 'S

Panamanian Food
Sancocho

> Stew w/ chicken and meat
> Fried Yucea roll w/ meat and boiled eoggs
Empanadas

> Corn/flour pastry w/ meat, potatoes and cheese

Carnival In Panama-

> Take place the four days prior to Ash
Wednesday.

> Panama's Carnival is the second
largest in the entire world

> The Panama City and
Las las, where the celebrating
takes place, fill up with parades,
costumes, floats, masks, and confetti.
> The highlight of many celebrations

includes the s n of the Carnival
Queen and her at

tendants.

EVALUATION:

The workshop must be uploaded to our virtual learning platform. Use the “TAREAS” tool to complete
this step. Make sure to upload a Microsoft PowerPoint file.

LANGUAGE

Teacher: Julio J. La Roche

INTRODUCTION

Topic: My Summer of Spies, pages 46-47

Over the next two weeks, you will develop new strategies to enhance reading comprehension. You
will acquire new vocabulary obtained from the assigned text. Also, you will be able to continually use
the strategies you already know to improve your fluency.



CONTENT:
The following subtopics will be discussed:

¢ Reading strategies to enhance comprehension.
e Vocabulary related to the assigned text.

e Moral lessons.

LEARNING ACTIVITIES:

Activity #1: Read My Summer of Spies on pages 46 and 47 from your Language textbook.

Activity #2: Join a Zoom Meeting in which the teacher will thoroughly explain the topic. Oral
assessments will be conducted to probe students' levels of understanding.

Activity #3: Complete the test.

Answer the questions based on the information provided on pages 46 and 47 in your language textbook. (15
points, 3 points each)

1. According to Rosie, who is the owner of the house?
2. What does Rosie think about spies?

3. When did her fascination with spies start?

4. What objects did the children find in the attic?

5. What did the children and their Granddad do at the end of the story?

EVALUATION:

The test must be uploaded to our virtual learning platform. Use the “TAREAS” tool to complete this
step. You can either upload a Microsoft word file or a photo you have taken.

SPELLING

Teacher: Julio J. La Roche Topic: Thinking Expressions, Idioms with Parts of the Body, page 34.

INTRODUCTION

Over the next two weeks, you will identify and use appropriately idioms with parts of the body in
written and spoken English. This will enhance your spelling skills and confidence in speaking and
writing.

CONTENT:

The following subtopics will be discussed:



e Thinking Expressions.
e Idioms with Parts of the Body.
e Several real-live statements using these expressions and idioms.

LEARNING ACTIVITIES:

Activity #1: Look up the meanings in English of the Thinking Expressions and Idioms with Parts of the
Body listed on page 34. Next, write them in your notebook. (Do not upload this)

Activity #2: Join a Zoom Meeting in which the teacher will explain the topic and conduct oral
assessments.

Activity #3: Complete the practice on page 34, sections 1, 2 and 3 in your Vocabulary and Grammar
textbook.

EVALUATION:

The practice must be uploaded to our virtual learning platform. Use the “TAREAS” tool to complete
this step. You can either upload a Microsoft word file or a photo you have taken.

GRAMMAR

Teacher: Julio J. La Roche Topic: Parts of the Speech, page 40.

INTRODUCTION

Over the next two weeks, you will state the definition of nouns, verbs, adjectives, and adverbs. You
will be able to use correctly the parts of the speech in written and spoken English. As a result, you will
have improved your skills to communicate effectively and appropriately in real-life situations.
CONTENT:

The following subtopics will be discussed:

e Parts of the Speech

LEARNING ACTIVITIES:

Activity #1: Look up the meanings in English of the Parts of the Speech listed on page 40. Next, write
them in your notebook. (Do not upload this)

Activity #2: Join a Zoom Meeting in which the teacher will explain the topic and conduct oral
assessments.

Activity #3: Complete the practice on page 40, sections 1, 2 and 3 in your Vocabulary and Grammar
textbook.



EVALUATION:

The practice must be uploaded to our virtual learning platform. Use the “TAREAS” tool to complete
this step. You can either upload a Microsoft word file or a photo you have taken.

Teacher: Jaime Archbold
INTRODUCTION: God uses unexpected ways to prove to us that he is interested in our well-being and is
willing to provide for us and supply our needs.
CONTENT:
Lesson 8: Quails and Manna

ACTIVITIES:

Use your Bible to complete workshop attached and upload to platform for evaluation by
9/18/2020.



INTERNATIONAL CHRISTIAN ACADEMY

COMMITTED TO EXCELLENCE
FIFTH GRADE SMS WORKSHOP

THIRD TRIMESTER, 2020

Total Pts: 13

Name:

Find the words
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ORAL SKILLS

Teacher: Speech: International Translators Day
Conversation #11: Holidays
Masai Gonzdlez Topic:  Conversation #12: What's for Dinner?

Finally, the Third Trimester is here. Don’t give up, we're almost done! © Let's get started!

INTRODUCTION

Learning to speak a language fluently takes time and patience. There are some things we can do to
make it fun and easier.

CONTENT:

e Speech: International Translator's Day
e Conversation #11: Holidays
e Conversation #12: What’s for dinner?

LEARNING ACTIVITIES:

Activity #1: Read in your ORAL SKILLS BOOKLET Conversations #11 and #12. Then, complete all the
activities with a PEN (black or blue ink), this means you should complete it by hand. Remember to
read carefully. (Do not upload this to platform)

Activity #2: Join a Zoom Meeting in which there will be an explanation of key concepts and a
discussion of the reading. It's important to come prepared to be able to answer the teacher's
questions and share answers with the class.

Activity #3: In commemoration of the “International Translator's Day” students will have to do
research and prepare a speech on this topic. The speech should include the answers to these
guestions: What is this day celebrating? When is it celebrated? Why is it important to celebrate the
work that translators and interpreters do? Which languages can be translated? What type of
situations or events might require a translator or interpreter? This speech will be presented the on
Wednesday, September 9th) during the ZOOM CLASS. IMPORTANT: Students should bring visual
aids to support the speech (poster board or PowerPoint Presentation).

Speech Rubric:

v Responsibility: The student brings the speech ready to present. Without READING IT.

v" Neatness: The student is properly dressed.

v’ Delivery: The student presents the speech clearly, exhibiting good pronunciation and
modulation of his/her voice.

v’ Creativity: The student brings a creative poster board or PowerPoint Presentation, etc. as
support.

Total Points: 15pts — Responsibility, Neatness and Delivery (5pts each)

Total Points: 5pts — Creativity



Profesora: Claudia Romero

Temas:

e El resumen de texto no literarios
e El articulo informativo.

Actividades:

e En la primera clase virtual estudiaremos el tema de la pagina
84, 85.
e Subir a la plataforma actividad de la pagina 87 del libro.

Recordatorio:

e El estudiante a lo largo del trimestre debe ir completando las
planas del libro de caligrafia hasta la dltima pagina, igual que
el libro de comprension lectora.

Profesora: Claudia Romero

Temas:

e Comunicacion y actividades econdmicas
¢ Vias de comunicacion

Actividades:

e En la primera clase virtual debatiremos tema nuevo y
desarrollaran la actividad de la pagina 114 del libro de texto.

e Subir a la plataforma actividad de la pagina 114 y 115 del libro
de texto.



ARTE

Docente: Alberto Gémez

Tema: El Color

Contenido
o ¢Qué son los colores primarios y secundarios?
o Colores primarios
o Colores secundarios

o Sus complementos

Para aprender sobre el tema realice lo siguiente

1- TALLER: 15 pts.

a-Realizaran una pintura sobre el tema, utilizando témpera, en la libreta de dibujo lo mas
amplio posible. Esta pintura sera hara durante la clase de Zoom. Ten a la mano los
materiales a la hora y fecha indicada en el cronograma de clases por videoconferencias.

Evaluacién

1-Taller Subir a la plataforma la imagen del taller terminado utilizando la herramienta
“TAREAS”.

2- Se evaluara:

a- Dibujo 5 pts.

b- Empleo de los colores y tonos 5 pts.

c- Limpieza en el trabajo. 5pts.

Profesor: Elvis R. Cordoba

INTRODUCCION
En este tercer trimestre conoceremos un poco acerca de los artistas y compositores locales. También
conoceremos su discografia y sus éxitos mas sobresalientes.

INVESTIGACION. COMPOSITORES NACIONALES
« RUBEN BLADES

Escriba una biografia corta (5 lineas) de Ruben Blades.
Escriba 5 de sus mayores éxitos.

Escriba 3 de sus dlbumes recientes.

EVALUACION
La informacién investigada debe ser leida y analizada, (no copiar y pegar).



Lo investigado debe ser informacién veridica a la biografia del artista.
o Esta actividad debe ser subida a la plataforma en la carpeta de muisica para evaluacion el VIERNES 18 de

septiembre.

EDUCACION FiSICA

Profesor: Gilberto Martinez Gutiérrez Tema: Educacion fisica — Terminologia

INTRODUCCION

Definimos terminologia como el conjunto de términos o vocablos propios de determinada profesién, ciencia o
materia, entendiendo el término, vocablo o palabra como la unidad linglistica que lo conforma. Agrupando estos
términos o vocablos en un escrito tenemos un glosario que no es mas que una lista de palabras y expresiones
clasificadas de un texto, autor o dialecto que son dificiles de comprender, cada una viene acompafiada de su
significado o de algln comentario cuya principal finalidad radica en que el lector alcance un mejor discernimiento
del tema tratado ampliando en esta forma su nivel de comprensidn sobre el mismo.

CONTENIDOS:
1. Glosario de términos deportivos.
ACTIVIDADES DE APRENDIZAIJE:

1. Realizarén detalladamente una lectura minuciosa y analitica de los diferentes términos, vocablos o palabras
proporcionadas en el glosario de términos deportivos que se le adjuntara en la agenda.

2. Resolveran dos (2) pruebas didacticas suministradas en la agenda atendiendo de forma rigurosa las siguientes
instrucciones.
» Paso 1: Dar lectura al glosario de términos deportivos suministrados hasta que considere haber alcanzado la
comprension del mismo. (No estudiar).
Paso 2: Descargue la prueba No.1 proporcionada en la agenda y habilite la herramienta de edicion.
Paso 3: Resolver la prueba No.1 proporcionada siguiendo las indicaciones. Es muy importante resolver esta
prueba sin ningun tipo de apoyo externo, ni textual ni verbal, realicelo solo.
Paso 4: Una vez realizada la prueba No.1 proceda a realizar la prueba No.2 utilizando apoyo del glosario de
términos y asegurandose que estén correctas todas las respuestas.
Paso 5: Después de haber realizado ambas pruebas proceda a contabilizar los puntos obtenidos en ambas
pruebas y coloque la cantidad de puntos de cada una en la parte donde dice (Puntos obtenidos: ). Valore con
dos (2) puntos las respuestas correctas y con cero (0) puntos las incorrectas.
» Paso 6: Guarde ambas pruebas y subalas a la plataforma en la seccién tareas correspondiente a educacion
fisica.

YV WV VYV

EVALUACION:

Sumativa: Se evaluara el proceso realizado al cumplir con los requerimientos de la actividad de la agenda mas
no el resultado obtenido en la actividad.



GLOSARIO DE TERMINOS DEPORTIVOS

1. Ejercicio fisico: es una actividad fisica planificada, estructurada y repetitiva, cuyo fin es mantener, desarrollar
0 mejorar nuestra forma fisica; entendiendo por forma fisica el nivel de energia y vitalidad que nos permite llevar
a cabo las tareas cotidianas habituales o la practica de deportes.

2. Deporte: todas las formas de actividades fisicas cuya practica supone entrenamiento y estan sujetas a normas
o reglamentacién, mediante una participacion organizada o no, que tienen como objetivo la expresion o la mejora
de la condicion fisica y psiquica, en el desarrollo de las relaciones sociales o la obtencién de resultados en
competicion de todos los niveles.

3. Actividad fisica: es todo movimiento corporal producido por los mdsculos que consuma o requiera un gasto de
energia por encima de un estado de reposo por ejemplo: nadar, correr, caminar, barrer, jugar, saltar, montar en
bicicleta y practicar deportes entre otros.

4. Posicion basica: Es una actitud fisica y mental que permite un estado elevado de atencién en la ejecucion de
movimientos rapidos en cualquier direccion dado en un tiempo minimo y que no podemos corregir sobre la
marcha.

5. Posicién inicial: es una postura, posicionamiento o ubicacién corporal a partir de la cual nace o se inicia un
desplazamiento para la realizacion o ejecucién de un determinado movimiento o accion.

6. Reglas bésicas o reglas fundamentales: son uno de los pilares de la mecénica general del juego, son
aquellas reglas o normas establecidas que regulan segun la estructura especifica de un juego o deporte todas las
acciones llevadas a cabo en su ejecucion y que todos los jugadores deben conocer para poder jugar.

7. Educacion fisica: es la disciplina pedagdgica que se encarga mediante el estimulo de la actividad fisica de los
procesos de instruccién o ensefianza y de formacién integral de la personalidad del individuo, eficientemente a
través del desarrollo de las capacidades fisicas, funcionales e intelectuales, inclusive de las habilidades motrices
deportivas, influyendo igualmente de forma positiva en la conducta social del ser humano.

8. Implemento deportivo: Instrumento, herramienta o aparato con caracteristicas particulares adaptadas que se
utiliza para practicar determinado deporte o actividad fisica.

9. Caracteristica: cualidad, particularidad o rasgo que sirve para distinguir, reconocer o diferenciar a alguien o a
algo de sus semejantes.

10. Fundamento técnico: desde el punto de vista del deporte, son aquellas actividades o acciones motrices que
son especificas o particulares de una determinada actividad deportiva y que realizadas en forma adecuada hacen
mas eficiente el movimiento, gastando menos energia y obteniendo mejores resultados en su ejecucion.

11. Pista, campo o0 cancha de juego: es un espacio reservado o utilizado especificamente para el desarrollo,
realizacion o la practica de un determinado deporte o actividad fisica, con caracteristicas y dimensiones
particularmente apropiadas a la actividad para la que fue concebida.

12. Indumentaria deportiva: es ropa especificamente creada para la practica de deporte, tanto por los materiales
y tecnologias empleadas como por las caracteristicas y disefios, proporcionandole al deportista comodidad,
seguridad y un mayor rendimiento en la actividad.

13. Director técnico o entrenador: en el deporte es la persona encargada de llevar en el proceso del
entrenamiento deportivo la direccidn, instruccion y preparacion, ya sea de un atleta individual o de un grupo o
colectivo de deportistas al cumplimiento de sus metas u objetivos.

14. Cuerpo técnico: es un grupo de colegas o profesionales conformado por entrenadores ayudantes,
preparadores fisicos, médicos, psicologos, nutricionistas, utileros etc. que se encargan de auxiliar o contribuir con
el director técnico en el cumplimiento de los objetivos de la planificacion y ejecucién del proceso de entrenamiento
deportivo.

15. Atleta: persona que posee una capacidad fisica superior a la media como resultado de un proceso de
entrenamiento deportivo, con caracteristicas como fuerza, agilidad, velocidad o resistencia, y en consecuencia es



apta para la realizacion de actividades fisicas, especialmente las competitivas.

16. Deportista: persona que realiza la practica de algin deporte o actividad fisica, ya sea por aficiébn o
profesionalmente, de acuerdo a la formalidad o al proceso al que se someta se le puede considerar como
aficionado o de alto rendimiento.

17. Ejercicios de orden: conjunto de acciones, movimientos o desplazamientos cuya principal funcion es
organizar, distribuir y ordenar de manera eficaz las actividades de un grupo o clase de educacion fisica atendiendo
una indicaciéon previa a una voz de mando para su ejecucién. Ejemplo: formaciones, giros, numeraciones,
distancias, estaturamiento, etc.

18. Formaciones: en educacion fisica son las figuras o formas adoptadas para agrupar, ordenar o distribuir a un
nimero determinado de participantes dispuestos para una actividad. Ejemplo: fila, columna, circulo, semicirculo,
cuadrado, etc.

19. Posiciones fundamentales: son aquellas que realizamos con nuestro cuerpo, que nos sirven como punto de
partida para la realizacién de formaciones, movimientos o ejercicios. Entre las mas comunes estan, de pie,
sentado, de cuclillas, de rodillas, cuadrupedia, decubito dorsal o abdominal.



Profesor Gilberto Martinez G.

INTERNATIONAL CHRISTIAN ACADEMY
COMMITTED TO EXCELLENCE
EDUCACION FiSICA

Valor de la prueba: 30 puntos Puntos obtenidos:

PAREO
EVALUACION DIAGNOSTICA No.1

Instrucciones: Lea detenidamente y con atencién TODA la prueba antes de empezar a responder. El nimero que representa al término
o palabra ubicada en la columna a su izquierda lo colocara en el espacio subrayado que corresponda a la definicion correcta del

término ubicada en la columna de la derecha.

1. IMPLEMENTO DEPORTIVO

2. POSICION INICIAL

3. INDUMENTARIA DEPORTIVA

4. EJERCICIOS DE ORDEN

5.DIRECTOR TECNICO O
ENTRENADOR

6. EJERCICIO FiSICO

7. REGLAS BASICAS

8. FUNDAMENTO TECNICO

9. ACTIVIDAD FiSICA

10. CARACTERISTICAS

11. PISTA, CAMPO O CANCHA
DE JUEGO

12. DEPORTE

13. EDUCACION FiSICA

Es una actividad fisica planificada, estructurada y repetitiva, cuyo fin es mantener, desarrollar o mejorar nuestra
forma fisica; entendiendo por forma fisica el nivel de energia y vitalidad que nos permite llevar a cabo las tareas
cotidianas habituales o la practica de deportes.

Desde el punto de vista del deporte, son aquellas actividades o acciones motrices que son especificas o
particulares de una determinada actividad deportiva y que realizadas en forma adecuada hacen mds eficiente el
movimiento, gastando menos energia y obteniendo mejores resultados en su ejecucion.

En educacion fisica son las figuras o formas adoptadas para agrupar, ordenar o distribuir a un numero
determinado de participantes dispuestos para una actividad. Ejemplo: fila, columna, circulo, semicirculo,
cuadrado, etc.

Cualidad, particularidad o rasgo que sirve para distinguir, reconocer o diferenciar a alguien o a algo de sus
semejantes.

Instrumento, herramienta o aparato con caracteristicas particulares adaptadas que se utiliza para practicar
determinado deporte o actividad fisica.

Todas las formas de actividades fisicas cuya practica supone entrenamiento y estdn sujetas a normas o
reglamentacién, mediante una participacion organizada o no, que tienen como objetivo la expresion o la mejora
de la condicion fisica y psiquica, en el desarrollo de las relaciones sociales o la obtencion de resultados en
competicidn de todos los niveles.

Es un espacio reservado o utilizado especificamente para el desarrollo, realizaciéon o la practica de un
determinado deporte o actividad fisica, con caracteristicas y dimensiones particularmente apropiadas a la
actividad para la que fue concebida.

Es una postura, posicionamiento o ubicacion corporal a partir de la cual nace o se inicia un desplazamiento para
la realizacion o ejecucidn de un determinado movimiento o accién.

Conjunto de acciones, movimientos o desplazamientos cuya principal funcidn es organizar, distribuir y ordenar
de manera eficaz las actividades de un grupo o clase de educacién fisica atendiendo una indicacién previa a una
voz de mando para su ejecucion. Ejemplo: formaciones, giros, numeraciones, distancias, estaturamiento, etc.

Es ropa especificamente creada para la practica de deporte, tanto por los materiales y tecnologias empleadas
como por las caracteristicas y disefios, proporcionandole al deportista comodidad, seguridad y un mayor
rendimiento en la actividad.

Es la disciplina pedagdgica que se encarga mediante el estimulo de la actividad fisica de los procesos de
instruccion o ensefianza y de formacion integral de la personalidad del individuo, eficientemente a través del
desarrollo de las capacidades fisicas, funcionales e intelectuales, inclusive de las habilidades motrices deportivas,
influyendo igualmente de forma positiva en la conducta social del ser humano.

Es un grupo de colegas o profesionales conformado por entrenadores ayudantes, preparadores fisicos, médicos,
psicologos, nutricionistas, utileros etc. que se encargan de auxiliar o contribuir con el director técnico en el
cumplimiento de los objetivos de la planificacidn y ejecucion del proceso de entrenamiento deportivo.

Son uno de los pilares de la mecanica general del juego, son aquellas reglas o normas establecidas que regulan
segun la estructura especifica de un juego o deporte todas las acciones llevadas a cabo en su ejecucién y que
todos los jugadores deben conocer para poder jugar.
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Es todo movimiento corporal producido por los musculos que consuma o requiera un gasto de energia por
encima de un estado de reposo por ejemplo: nadar, correr, caminar, barrer, jugar, saltar, montar en bicicleta y
practicar deportes entre otros.

En el deporte es la persona encargada de llevar en el proceso del entrenamiento deportivo la direccidn,
instruccion y preparacion, ya sea de un atleta individual o de un grupo o colectivo de deportistas al cumplimiento
de sus metas u objetivos.
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Es una actividad fisica planificada, estructurada y repetitiva, cuyo fin es mantener, desarrollar o mejorar
nuestra forma fisica; entendiendo por forma fisica el nivel de energia y vitalidad que nos permite llevar a cabo
las tareas cotidianas habituales o la practica de deportes.

Desde el punto de vista del deporte, son aquellas actividades o acciones motrices que son especificas o
particulares de una determinada actividad deportiva y que realizadas en forma adecuada hacen mas eficiente

el movimiento, gastando menos energia y obteniendo mejores resultados en su ejecucion.

En educacién fisica son las figuras o formas adoptadas para agrupar, ordenar o distribuir a un numero

determinado de participantes dispuestos para una actividad. Ejemplo: fila, columna, circulo, semicirculo,
cuadrado, etc.

Cualidad, particularidad o rasgo que sirve para distinguir, reconocer o diferenciar a alguien o a algo de sus
semejantes.

Instrumento, herramienta o aparato con caracteristicas particulares adaptadas que se utiliza para practicar

determinado deporte o actividad fisica.

Todas las formas de actividades fisicas cuya practica supone entrenamiento y estdn sujetas a normas o

reglamentacidon, mediante una participacion organizada o no, que tienen como objetivo la expresiéon o la
mejora de la condicidn fisica y psiquica, en el desarrollo de las relaciones sociales o la obtencidn de resultados

en competicién de todos los niveles.

Es un espacio reservado o utilizado especificamente para el desarrollo, realizacién o la practica de un

determinado deporte o actividad fisica, con caracteristicas y dimensiones particularmente apropiadas a la
actividad para la que fue concebida.

Es una postura, posicionamiento o ubicacion corporal a partir de la cual nace o se inicia un desplazamiento
para la realizacion o ejecucién de un determinado movimiento o accion.

Conjunto de acciones, movimientos o desplazamientos cuya principal funcién es organizar, distribuir y ordenar
de manera eficaz las actividades de un grupo o clase de educacion fisica atendiendo una indicacién previa a

una voz de mando para su ejecucion. Ejemplo: formaciones, giros, numeraciones, distancias, estaturamiento,
etc.

Es ropa especificamente creada para la practica de deporte, tanto por los materiales y tecnologias empleadas
como por las caracteristicas y disefios, proporcionandole al deportista comodidad, seguridad y un mayor
rendimiento en la actividad.

Es la disciplina pedagdgica que se encarga mediante el estimulo de la actividad fisica de los procesos de
instruccidn o ensefianza y de formacién integral de la personalidad del individuo, eficientemente a través del
desarrollo de las capacidades fisicas, funcionales e intelectuales, inclusive de las habilidades motrices
deportivas, influyendo igualmente de forma positiva en la conducta social del ser humano.
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Es un grupo de colegas o profesionales conformado por entrenadores ayudantes, preparadores fisicos,
médicos, psicélogos, nutricionistas, utileros etc. que se encargan de auxiliar o contribuir con el director técnico
en el cumplimiento de los objetivos de la planificacion y ejecucion del proceso de entrenamiento deportivo.

Son uno de los pilares de la mecanica general del juego, son aquellas reglas o normas establecidas que regulan
segun la estructura especifica de un juego o deporte todas las acciones llevadas a cabo en su ejecucién y que
todos los jugadores deben conocer para poder jugar.

Es todo movimiento corporal producido por los musculos que consuma o requiera un gasto de energia por
encima de un estado de reposo por ejemplo: nadar, correr, caminar, barrer, jugar, saltar, montar en bicicleta y
practicar deportes entre otros.

En el deporte es la persona encargada de llevar en el proceso del entrenamiento deportivo la direccidn,
instruccidon y preparaciéon, ya sea de un atleta individual o de un grupo o colectivo de deportistas al
cumplimiento de sus metas u objetivos.



